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2 GETTING STARTED

Welcome to the 2010 FRC season.  We strongly suggest teams complete the steps below to 
perform an out of the box benchtop test before using any of the components to build a robot.  

The OTB Test is a way to 
- determine your Driver Station system is functional at a basic level
- assure that devices weren’t damaged in shipping
- ensure the Classmate and cRIO are imaged correctly
- verify Classmate operation with the Robot Controller. 
-

If you have feedback on the system or this document please post your comments on the FIRST 
Control System Forum at http://forums.usfirst.org/forumdisplay.php?f=23

2.1   STEP 1 – ACQUIRE NEEDED DOCUMENTATION
You will need the following documents as you assemble your control system.   Before you even 
open the Kit of Parts, we suggest you print out the documentation listed below and assemble it in a 
binder ready for immediate reference by your team.

 FRC Control System Manual, Chapter 1 Introduction
 FRC Control System Manual, Chapter 2 Getting Started (this document)
 FRC Control System Manual, Chapter 3 Control System Component Datasheets
 Kit of Parts Checklist http://usfirst.org/roboticsprograms/frc/content.aspx?id=452
 2010 Robot Power Distribution Diagram

http://usfirst.org/roboticsprograms/frc/content.aspx?id=10934
 2010 Robot Data Connectivity Diagram

http://usfirst.org/roboticsprograms/frc/content.aspx?id=10934

2.2   STEP 2 – IDENTIFY AND INVENTORY CONTROL SYSTEM COMPONENTS
Identify each of the components in your kit using the descriptions and photos provided in the Kit of 
Parts Checklist. http://usfirst.org/roboticsprograms/frc/content.aspx?id=452Record the quantities 
you received on your printed checklist. Report any inconsistencies within 3 days of receiving your 
kit to TIMS as directed in the 2010 Competition Manual 
http://usfirst.org/roboticsprograms/frc/content.aspx?id=452
Veteran teams will need to gather the following items from the 2009 Kit of Parts:

 cRIO
 1 analog breakout
 1 digital side car
 joysticks
 panel signal device
 robot radio & driver station radio
 solenoid breakout
 2 standoffs
 1 DB37 extension cable
 4 Wago power connectors
 1 spike relay
 2 Jaguar motor controllers
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2.3STEP 3 - INSTALL SOFTWARE ON THE COMPUTER YOU PLAN TO USE FOR 
DEVELOPMENT

The 2010 FRC Control System can be programmed in LabVIEW, Java or C/C++.  Teams should 
choose their programming language at this point.  Teams may choose National Instruments 
LabVIEW, which supports a graphical programming language; Wind River Workbench, which 
supports C and C++ languages; or Net-Beans which supports Java.  After compiling, executables 
are transferred to the cRIO.

The Install DVDs in the new control system kit contain the FRC versions of the following tools:
LabVIEW Package

LabVIEW
LabVIEW Real-Time
PID Control Toolkit
FRC Additional Files for LabVIEW

Wind River C++ Package
Wind River C++ Platform
Wind River Toolkit for FRC

Java Package
Java(TM) SE Development Kit
Sun(t) SPOT Java(t) Development Kit for FRC
NetBeans IDE 6.7.1 Installer

Required Dependencies
VISA RT FRC
NI-RIO
Vision
Vision Assistant 2009 Hotfix
Vision Plugin
FRC License

2.3.1 Licensing
The National Instruments LabVIEW license is active until Jan 15, 2011. Java has no expiration 
date.

Teams are permitted to install the software on as many team computers as needed, subject to the 
restrictions and license terms that accompany the applicable software, and provided that only team 
members or mentors use the software, and solely for the FRC.  Rights to use LabVIEW and 
Workbench are governed solely by the terms of the license agreements that are shown during the 
installation of the applicable software.

2.3.2 Installation Requirements
The installation has been tested on Windows XP operating system.  National Instruments and Wind 
River have not finished their compatibility testing with Windows Vista or Windows 7, and thus won’t 
be supporting it for the 2010 FRC season. We don’t know of any reasons why it wouldn’t work, but 
wanted to let you know that if you use the development software on Windows Vista or Windows 7, 
you do so at your own risk.

To install, you must be logged on as an administrator or as a user with administrator privileges. You 
will need Internet access to activate the Wind River and NI Licenses. 

Requirements for the LabVIEW Programming Environment

Please note: while one person progresses through steps 3 and 4 using the computer your 
team plans to use for development, a second person may complete steps 5 
and 6 at the same time using the Classmate provided in your kit of parts.
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Installation of the “LabVIEW Package” from the FRC DVD requires 3.6 GB total disk space.  On a 
Windows XP platform, this package takes an average of 1.5 hours to install.  Installation on a Vista 
operating system sometimes takes longer. If you currently have National Instruments software on 
your PC, it will not interfere with that installation.  However it will install over another version of 
LabView 8.6.

Requirements for the C/C++ Programming Environment
Installation of the “Wind River Package” from the FRC DVD requires 2.4 GB total disk space.  Note 
that even the C/C++ programming environment will require installation of many portions of the NI 
software to support the cRIO.   On a Windows XP platform the Wind River software takes an 
average of ½ hour to install. The FRC installation must be installed in the directory ”c:\WindRiver”.  
A different version of Workbench on your PC can remain installed, but it must be in a different 
directory.

Users of the software must read the license agreements that are shown during installation of the 
software carefully and completely.

Requirements for the Java Programming Environment
Installation of the “Java package” from the FRC DVDs requires a minimum of 350 MB disk space 
and 512 RAM. Note that even the Java programming environment will require installation of many 
portions of the NI software to support the cRIO.   On a Windows XP platform the Java software 
takes an average ½ hour to install. Users of the software must read the license agreements that are 
shown during installation of the software carefully and completely.

2.3.3 Before Installing

Deactivate / Uninstall software
1. Disable any automatic virus detection programs before you install. Some virus detection 

programs interfere with installation.  (NOTE:  Some of the beta test teams that did not 
disable virus detection before installation needed to re-install their programming 
environments again to remedy problems encountered in installation.) 

2. If you have the FIRST Tech Challenge software installed, use the Switch Palette Set dialog 
box, accessible by selecting Tools»Switch Palette Set in LabVIEW, to switch to the 
Complete LabVIEW palette set before installing the FRC software.

3. If you have another version of the Wind River Workbench installed, make sure it is not in the 
C:\WindRiver directory because that is the preferred location for the FRC installation (some 
of the tools expect that location).

Obtain licenses
The install DVD jacket has the serial number to use for LabVIEW activation. If this is not available, 
LabVIEW may be activated temporarily for 30 days without a license.  
The Wind River Workbench License Authorization Code (LAC) is pre-populated in the installer.

2.3.4 Install LabVIEW 8.6 and Associated Components

Installation Procedure
Insert the FIRST Robotics Competition Software installation DVD 1 and follow the instructions that 
appear on the screen.

Activation Procedure
After the NI software is installed, an NI Activation Wizard starts. (This may happen while the second 
installation disk is working). Activate the product using the serial number obtained on the certificate 
of ownership in the software package in your kit of parts. 
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If you obtain a license later, follow this procedure to activate LabVIEW permanently: 
1. From the Start Menu, select:  Programs >> National Instruments >> NI License Manager. 

The License Manager dialog asks you what you would like to activate.  
2. Choose "Automatically activate thru a secure internet connection.” You only need to enter in 

the number for LabVIEW 8.6 Development System.  This will activate all the National 
Instruments programs that you need for FRC.

3. Press the Activate Button.

Check http://joule.ni.com/nidu/cds/view/p/lang/en/id/1534 for LabVIEW updates and install.  It is a good 
idea to check this regularly during the build season as updates are posted as they become 
available.

2.3.5 Install Wind River Workbench

Installation Procedure
Note: If you have just installed the previous DVD, the National Instruments Activation Wizard may 
start while Workbench is being installed. Internet access is needed to complete the install for 
Workbench.

Put the second DVD into the reader. After a few minutes the Installer-Welcome screen will appear. 
Click Next.

At the Installer-License Agreement screen, select I ACCEPT (if you agree) and click Next.
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At the Installer-Installation Directory screen, keep the default installDir directory or enter one of your 
choosing. All Wind River products should be installed into the same installDir (root installation 
directory.)
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At the Installer-Choose Activation Type screen, select Permanent activation and click Browse.
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Browse to the DVD-R138732.1-1 directory and select FirstRobotics_2010_install.txt file. Click 
Open.  No internet connectivity is required to obtain your product activation file 
(FirstRobotics_2010_install.txt).
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The FirstRobotics_2010_install.txt file contains the installation keys and licensing needed to install 
and activate Wind River products.  Once the path to the FirstRobotics_2010_install.txt (product 
activation file) is displayed under Permanent activation, click Next.
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At the Installer-Choose Installation Filters screen, make no changes. Click Next.
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At the Installer-Standard Installation screen, click Install.  After a few minutes, the installation 
process will begin by showing a green status bar in the Overall Installation Progress box.
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Once the Overall Installation Progress shows (installed 7 of 7 selected products), click Next.
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Read the information shown on the Installer-readme.txt screen. This readme is installed as 
FRC_readme.txt in your installDir. Click Next.
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At the Installer-Finish screen, we recommend keeping both choices selected with a check mark. 
Click Finish.  After a few minutes, Wind River Workbench will start up (if you kept the Launch 
selection check marked.)
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Note: The product activation file, FirstRobotics_2010_install.txt, is renamed as install.txt when the 
Installer puts it into your installDir.  To start Workbench manually, see the instructions in the 
readme.txt file located in your installDir.

2.3.6 Install Net Beans and Java

Installation Procedure

The following procedure explains how to install the Java software development environment from 
the FIRST DVD.  In addition to the NetBeans Integrated Development Environment and The Java 
SE JDK, necessary National Instruments and FRC components will be installed.  Installation of only 
the Java environment should take about ½ hour.  

Additional information is available at http://first.wpi.edu/FRC/frcjava.html

Put the DVD into the reader. After a few minutes the Installer screen will appear. 
On the installer welcome page, click  “Install FIRST Robotics Competition 2010 Software”.
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The Installer information page will appear.  Click “Next >>”.

The Product List dialog box will appear.  To choose the Java Package, right-click on “Java 
Package” and choose “Install”.  To install only Java, right-click “LabVIEW Package” and “Wind River 
Package” and choose “Do not install”.



© FIRST 2010 FRC Control System Manual: Section 1 – Introduction, Rev1 Page 17 of 58

The Product List with the Java Package selected should appear as shown.  Click “Next >>”.
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The Product Information dialog will appear.  Click “Next >>”.

The User Information dialog will appear.  Enter your team name, Organization FIRST and the 
LabVIEW serial number found on the certificate of ownership located in the software package 
provided in your kit of parts.  Click “Next >>”.
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In the Destination Directory dialog, keep the suggested directory and click “Next >>”.

Accept the National Instruments License Agreements and click “Next >>”.
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When the Start Installation dialog appears, click “Next >>”.

After the National Instruments products have been installed, the JDK SE License dialog will appear,  
Click “Accept >”.

The JDK SE Custom Setup dialog box will appear.  Click “Next >”.
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When the JDK SE Complete dialog appears, click “Finish”.

When the FRC Java Installer appears, keep the default destination folder and click “Install”.
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When the NetBeans Installer dialog appears, click “Next >”.
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Accept the NetBeans IDE License Agreement and click “Next >”.

Keep the NetBeans IDE Installation default folders and click “Next >”.
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A Summary message box will appear. Click “Install”.

When Setup is Complete, decide whether to contribute and register and click “Finish”.
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Finally, an Installation Summary page will appear.  Click “Next >>” to complete the installation.

FRC Plugin Installation and Configuration

The FRC Plugins can either be installed from the Internet or from the C:\FRCJava\update folder 
created by the DVD installation.  Internet installation is recommended because future updates will 
be immediately available to you through the WPILib update site.  If the Internet is not available the 
plugins can be installed from disk.  To install the plugins, start NetBeans and choose “Tools > 
Plugins” to access the Plugins dialog box.  

To install the plugins from the Internet:

In the Plugins dialog box, choose the “Settings” tab and “Add” to access the Update Center 
Customizer dialog.  Enter “FRC Java” in the “Name:” field.  Enter the current plugins URL, 
(http://first.wpi.edu/FRC/java/netbeans/update/fpga1.3.0/updates.xml) in the “URL:” field.  Then 
click “OK”.
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In the Plugins dialog box, choose the “Available Plugins” tab, and check the Install box for every 
Plugin in the list that begins with “FRC”.  Click “Install”.
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To install the plugins from disk:

In the Plugins dialog box, choose the “Downloaded” tab and “Add Plugins…” to access the Add 
Plugins file browser.  Navigate to C:\FRCJava\updates, select the plugin files (*.nbm), and click 
“Open”.

In the Plugins dialog box, click “Install”.

To complete the plugins installation:

In the NetBeans IDE Installer dialog, click “Next >”.
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Accept the terms of the license agreement and click “Install”.

Wait while the plugins are downloaded and installed, then click “Finish” to restart the IDE now.
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To configure the FRC Plugins:

When NetBeans restarts, click “Tools > Options”.

In the Options dialog, click the “Miscellaneous” icon and the “FRC Configuration” tab.  Enter your 
team number in the “Team Number:” field and click “OK”.

NetBeans is now ready for use in creating, building and running FRC Java robot programs.

2.4 STEP 4 – UPDATE SOFTWARE 

1. Go to  http://joule.ni.com/nidu/cds/view/p/lang/en/id/1534
2. Click on the FRC update file.
3. Follow the instructions that appear on the screen to complete the update.

2.5STEP 5 – 2010 DRIVER STATION CONTROL SYSTEM SET UP

Initial Driver Station Boot
Attach the Classmate to the power adaptor and plug the adapter in to an AC power receptacle.  The 
first time the Classmate is turned on, there are some unique steps, listed below, that you’ll need to 
take. We recommend that you wait until after you’ve done these steps before connecting your 
Classmate to the internet. The initial boot may take several minutes; make sure you do not cycle 
power during the process. Please note that these steps are only required during original startup. 

SET UP Wizard
a) When the Wizard starts, click Next.
b) Read, and if appropriate, accept the user license agreement. (If you do not accept the user 

license agreement, I’m afraid we’re in trouble…)
c) When prompted for “Computer Name,” use your team number in the following format -

Teamxxxx, where xxxx is your four-digit team number (i.e. Team 0012, Team0123, Team 
1234, etc).  We suggest that you describe your computer as “driver station”.
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d) Next you will be prompted for an administrator password.  We urge you to set the 
administrator password to something known only to you and to keep it confidential. Do not
share the password with your entire group, but instead only with a select few trusted 
individuals. 

e) You will be asked if you want to assign your computer to a domain. Click no.
f) The wizard will check for an internet connection. Again, we recommend that you wait until 

after you’ve done these steps before connecting your Classmate to the internet. Click next.
g) You will be asked if you are ready to register with Microsoft at this time.  Please choose: not 

at this time.
h) Wait for Windows to install networking components and complete the final tasks. 
i) The Classmate will direct you to the account login screen. Log into the Developer account.

AVG Antivirus set up
You should get a message that the AVG license is not working. If it doesn’t pop up right away, give 
it a minute, it will. NOTE: We expect that you may also receive a message that says that AVG is out 
of date. In future, we recommend that you keep your AVG Antivirus software current and update 
when prompted to do so. 

a) Click the Reenter key. 
b) Enter your licensing information.

a. Your user name is the same as your computer name (Teamxxxx)
b. Your company is FIRST
c. The license number is 8FIRST-N0T27-LEECS-8ZNAR-Y2ENL-8BFMA-PFYJ (note 

that the second batch of letters has a “zero” not a capitalized vowel.). 

c) Click Activate.
Your license will activate upon initial connection to the internet and is good for one year. 

Set Developer Password
We urge you to set the Developer account password to something known only to you and to keep it 
confidential. Do not share the password with your entire group, but instead only with a select few 
trusted individuals. This will go a long way in preventing unwanted and uncontrolled system 
modifications and resultant instability or data loss. Be sure to save the password in a secure 
location; if the password is lost, you will not be able to login as Developer nor perform actions 
requiring administrator-level privileges. Should this happen, you will need to contact FIRST for 
instructions on how to re-image your machine, potentially a time-consuming task.

a) Open the Control Panel. 
b) Click on User Accounts.
c) Click on Developer and click Create a Password. 
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d) You will be asked, “Do you want to make your files and folders private?” Answer 
accordingly.

e) Close user accounts.

Update Classmate Software
In order for the Classmates to arrive at Kickoff locations in time, they were shipped before the final 
version of the software was ready.  It is essential that you update your classmate software before 
proceeding so that you are using the most updated software throughout this set up and during 
competition.

a) Using a separate computer that is connected to the internet, retrieve the driver station 
update http://joule.ni.com/nidu/cds/view/p/lang/en/id/1535 and save the files to a USB drive 
NOTE: do not use the restoration key provided in the 2010 kit of parts.  The restoration 
key should be kept pristine and stored in a safe location.  The restoration key should be 
used only in the event of a crashed classmate. 

b) Insert the USB drive into the Classmate, when the removable disk window pops up 
choose Open folder and view files.

c) Move the Update Folder to Classmate desktop
d) Open file
e) Click setup.exe
f) Choose next
g) Choose next
h) Product notifications are optional.  Answer as you see fit.
i) Read, and if appropriate, accept the user license agreement. (If you do not accept the 

user license agreement, I’m afraid we’re in trouble…)
j) Ditto for the supplemental license agreement
k) After the software loads, choose finish and restart the computer when prompted

Set your team number
When the classmate reboots it will automatically open the Driver account.

a) Click on the Set up Tab and enter your team number in the field provided and Tab out of the 
field. As noted above, we’ve used team number 9999 for these examples. 

2.6STEP 6 - CONFIGURE THE CRIO
All FRC teams, both Rookie and Veteran teams, must configure/reconfigure the cRIO in preparation 
for the 2010 season. The cRIO Imaging Tool is preloaded on the Classmate and is also available 
on the Software Disks included in the Kit of Parts.  

Set the Static IP Address of the Computer you are using for development
1. Select Start»Control Panel»Network Connections»Local Area Connection to display the 

Local Area Connection Properties dialog box.
2. On the General page, select Internet Protocol (TCP/IP) 
3. Click the Properties button to display the Internet Protocol (TCP/IP) Properties dialog box.
4. Select the Use the following IP address option.
5. In the IP address text box, if this computer is the Classmate and you have run the Driver 

Station software and successfully set your team number, you should see 10.xx.yy.5, where 
xx corresponds to the first one or two digits of your team number and yy corresponds to the 
last two digits of your team number.   If this is not the classmate PC you should set the 
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address to 10.xx.yy.6 as the Driver Station defaults to 10.xx.yy.5 for its IP address. In this 
text box, change the final digit .5 to .6.

Team Number Static IP Address
64 10.0.64.6
512 10.5.12.6

1024 10.10.24.6

6. The Subnet mask text box defaults to 255.0.0.0. Use this default value.

7. Click the OK button twice to close the Internet Protocol (TCP/IP) Properties and Local Area 
Connection Properties dialog boxes.

8. Click the Close button to close the Network Connections dialog box.

After you set the static IP address of the computer you are using for development, use an Ethernet 
crossover cable to connect that computer to Ethernet port 1 of the cRIO. Power up the cRIO, then 
configure the cRIO with the cRIO Imaging Tool. 

Considerations Before Running the cRIO Imaging Tool
Before configuring the cRIO with the cRIO Imaging Tool, you must ensure that the hardware and 
software are configured properly.

Do not use the cRIO Imaging Tool on the cRIO over a wireless connection. If the connection is lost, 
the data that the cRIO Imaging Tool writes to the cRIO will be corrupted.

Do not use Measurement and Automation Explorer (MAX) to install additional software on the cRIO. 
MAX overwrites the FRC VIs on the cRIO, which makes the cRIO unusable for the FRC 
competition. If you use MAX to install additional software on the cRIO, you must use the cRIO 
Imaging Tool to restore the device to a usable state.

Before running the cRIO Imaging Tool, ensure the SAFE MODE switch on the cRIO is turned off. 
For routine use, do not use the cRIO Imaging Tool when the cRIO is in SAFE MODE. 
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Severe corruptions of the software or settings on the cRIO result in the device no longer 
functioning. If the cRIO is corrupted or if the IP Address is set incorrectly, the device boots only in 
SAFE MODE. When this occurs, switch the device into SAFE MODE. The cRIO Imaging Tool offers 
to reformat the disk. After the disk has been reformatted, switch the cRIO out of SAFE MODE, 
reboot, and run the cRIO Imaging Tool normally

Running the cRIO Imaging Tool
Complete the following steps to configure the cRIO with the cRIO Imaging Tool.

1) Select Start»All Programs»National Instruments(folder)»LabVIEW 8.6»FRC cRIO Imaging 
Tool to launch the cRIO Imaging Tool dialog box. You also can display this dialog box by 
selecting Tools»cRIO Imaging Tool in LabVIEW.

2) Select the cRIO you want to configure from the Select cRIO Device table. This table lists all 
cRIO devices connected to the host computer.

3) In the Development Environment section, specify whether you want to run and debug 
LabVIEW, C/C++, or Java .

a. When developing robot code using LabVIEW it is recommended that the ”Always run 
deployed code at startup” option be selected.

4) Place a checkmark in the Format Controller checkbox. Use the Format Controller section to 
restore an image on the cRIO or update the cRIO with a new name or team ID.

5) From the Select Image list, select the most recent FRC_2010_xx.zip file to download the 
FRC_2010_xx image to the cRIO. The FRC_2010_xx image consists support for  LabVIEW, 
C/C++, and Java program.

6) Enter the name you want to use to identify the cRIO in the Device name text box.
7) Enter your team number in the Team ID field. The cRIO Imaging Tool sets the IP address of 

the cRIO to 10.xx.yy.2, where xx corresponds to the first or first two digits of the team 
number and yy corresponds to the last two digits of the team number.

8) Click the Apply button to apply the changes you made and download the FRC_2010_xx 
image to the cRIO. Do not turn off power to the cRIO or interfere with the network 
connection while the cRIO Imaging Tool downloads the image to the cRIO.

9) When the reconfiguring device window states the CompactRIO image was successfully 
updated, close the window, turn the cRIO off by shutting down the power, then turn it back 
on to load the new image.

If you want to switch to another development environment, select the new development 
environment from the Choose Development Environment section and click the Apply button. 
Switching development environments does not reformat or download a new image to the cRIO.

Refer to the LabVIEW Robotics Programming Guide for the FIRST Robotics Competition for more 
information about the cRIO and other programming procedures. You can access this guide by 
selecting the Robotics Programming Guide link on the LabVIEW Getting Started window, by 



© FIRST 2010 FRC Control System Manual: Section 1 – Introduction, Rev1 Page 34 of 58

navigating to the National Instruments\LabVIEW 8.6\manuals directory and opening 
FRC_Getting_Started.pdf, or by searching ni.com

2.6.1 Using the Classmate with your cRIO.

1) Log into the Driver Account

Figure 1: Login screen with the two available accounts

2) Plug the following devices into your Classmate
- USB Hub
- Joysticks (into the USB Hub)
- E-Stop button (into port 1 on the USB Hub) 
- cRIO using the orange crossover Ethernet cable (via the only Ethernet port on the 

Classmate and port 1 on the cRIO)

Figure 2: The basic Driver Station setup with simulated robot (cRIO, motors, etc)
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3) Turn on your cRIO using the 120A main circuit breaker (make sure that the Analog Breakout 
Board is attached to the 9201 module in slot 1 of your cRIO and that it has the jumper 
installed for battery voltage tracking). 

Figure 3: The cRIO should have a 9201 module in slot 1 with 
the accompanying Analog Breakout board installed and wired

4) On the left side of the Driver Station window, check the status indicators to confirm that the 
Classmate has communication with the cRIO (meaning that IP addresses are set and the 
cRIO has been imaged), This will be indicated with a green light next to Communications.

Figure 4: Status indicators relay crucial information about system performance.
5) In the Setup Tab, confirm that the Driver Station recognizes your joysticks. Joysticks should 

be listed in green. If the joysticks were not connected or recognized hit F1 to cause the DS 
to re-enumerate the USB joystick devices.

2.7STEP 7 – ROBOT CONTROL SYSTEM SET UP
Veteran teams may skip this step and use their 2009 robot in place of the bench top set up when 
testing the Driver Station set up throughout the rest of this document.

Locate the following control system components and layout their locations on an appropriate 
nonconductive surface (e.g. plywood or lexan) to permit wiring connections as shown in the power 
distribution diagram http://usfirst.org/roboticsprograms/frc/content.aspx?id=10934.  Plan the 
positions of the components to leave space to access the various connectors.

 Kit Materials:
o Power Distribution Board
o cRIO with modules (2x NI 9201 in slots 1,2; 2x NI 9403 in slots 4,6; NI 9472 in slot 8)
o Analog Breakout (to be installed with the NI 9201 module in slot 1)
o Digital Sidecar (to be connected to the NI 9403 module in slot 4)
o Solenoid Breakout (to be installed with the NI 9472 module)
o Wireless bridge, WGA600N
o Circuit breakers

Analog Breakout Board

Required Jumper
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o Jaguar speed controllers, qty 2 (Team-provided Victor 884 speed controllers may 
also be used)

o 2 PWM cables
o Crossover cable
o 120-amp circuit breaker (CB3-SM-120 or similar)
o 12V DC motors, qty 2
o 6 AWG wire and ring terminal connectors
o 22 AWG or better wire
o 18 AWG or better wire
o appropriate wire and connectors for size of motors
o 12V Battery (MK Battery ES17-12 or equivalent)

 Tools Required:
o Wago Tool (from kit)
o M6 nut driver (10mm socket)
o Jeweler’s flat-head screwdriver
o Wire cutters, strippers, and crimpers
o

An example of a completed bench top setup (excluding the wireless bridge) is shown in Figure 2.1. 

Figure 2.1 Completed Robot Control System benchtop setup

Power Distribution Board (PD) – Make each of the following connections. Refer to the Power 
Distribution Board datasheet in section 3.1 for additional detailed information.

• 12V Power connection to the Power Distribution Board from the 120-Amp circuit Breaker
WARNING: the shanks on the Power Distribution Board use metric M6 nuts. Use of ¼” nuts 

will strip the studs on the Power Distribution Board.
NOTE: Do not connect a battery to the Power Distribution Board until after all other 

connections are established and double-checked.
• 24V Power connection to the cRIO 
• Power connections to the Analog Breakout, Digital Sidecar, and Solenoid Breakout from the 

VB3 breaker outputs (use 20A breaker).
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• Power connection to the Jaguar Speed Controllers from any of the Maxi Breaker outputs (for 
40A circuits) 

cRIO – Make each of the following connections. Refer to the cRIO manual link available in section 
3.2 for additional detailed information.

• cRIO Module Positions
• Slot 1: 9201 (with Analog Breakout)
• Slot 2: 9201 (optional)
• Slot 3: Empty
• Slot 4: 9403 (connected to Digital Sidecar)
• Slot 5: Empty
• Slot 6: 9403 (optional)
• Slot 7: Empty
• Slot 8: 9472 (connected to Solenoid Breakout) (optional if needed).
• Connect the 24V cRIO supply from the PD board using the supplied power connector (Part NO 

CTF040V8) 
• Plug the crossover cable from network port 1 to the Driver Station

Analog Breakout – Make each of the following connections. Refer to the Analog Breakout 
datasheet in section 3.3 for additional detailed information.

• Plug the Analog Breakout to the NI 9201 module installed in slot 1 of the cRIO
• Connect J3 to the Power Distribution Board using a 20A Circuit
• Install a jumper on the Analog Breakout’s “Battery Selection Jumper” in accordance with the 

Analog Breakout Datasheet to enable battery monitoring.

Digital Sidecar – Make each of the following connections. Refer to the Digital Sidecar datasheet in 
section 3.4 for additional detailed information.

• Using the supplied DB-37 ribbon cable, connect to the NI 9403 module installed in slot 4 of the 
cRIO. NOTE: Remove the hex nuts from the female side of the cable.

• Connect J22 to the Power Distribution Board using a 20A Circuit
• Connect PWM cables to Jaguar Speed Controllers (PWM #1 to Jaguar #1; PWM #2 to Jaguar 

#2). 

Solenoid Breakout – Make each of the following connections. Refer to the Solenoid Breakout 
datasheet in section 3.5 for additional detailed information.

• Plug the Solenoid Breakout into the NI 9472 module installed in slot 8 of the cRIO
• Connect J3 to the Power Distribution Board using a 20A Circuit

120-Amp Circuit Breaker – Make each of the following connections.
• Connect the “BAT” terminal to the “+” terminal of an Anderson connector
• Connect the “AUX” terminal to the “+” terminal on the PD board.

Jaguar Speed Controllers and 12VDC Motors – Make each of the following connections for each 
of the two Jaguar speed controllers and associated 12VDC motors.  Refer to Section 3.1 for 
additional information 

• Connect the “V-” terminal to the “-” output of either a Maxi or VB3 breaker on the PD board
• Connect the “V+” terminal to the “+” output of the same Maxi or VB3 breaker on the PD board
• Connect the “M-“ terminal to one of the motor input leads
• Connect the “M+” terminal to the other motor input lead of the same motor

Wireless Bridge (WGA600N) – Make each of the following connections.
• Plug the 12V / 1A power supply included with the WGA600N wireless bridge into a wall outlet 

and into the bridge. The bridge can alternatively be powered from the robot using the 12V 
supply included on the Power Distribution board. 
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NOTE: Do not connect the Ethernet cable between the bridge and the cRIO at this time. The 
first benchtop test will utilize “tethered” operation. Only after completion of the test with 
tethered operation will the bridge be used for a wireless connection to the Driver Station.

At this point, your electrical wiring for the “robot” portion of the benchtop test should be complete.  
Before turning the benchtop system on, ensure that all power connections are connected with the 
proper polarity and that any power cables you manufactured are correct. Applying reversed power 
will permanently damage many of the control system components (e.g. the wireless adapters and 
Jaguar speed controllers). 

2.7.1 Confirmation of LED Status on Control System Components
Before powering on either your robot or your “bench top” system, ensure the motors are located in 
such a way that if they were to become immediately operational, they would not pose a safety 
hazard. Also ensure the joysticks plugged into the Driver Station are ‘centered’.

1. Connect a battery to the Anderson connector of the “benchtop test” setup. Turn on the 
power to the “benchtop test” setup at the Hi-Amp 120A circuit breaker.

2. Immediately after turning on the power, confirm that each of the items below is operating 
correctly:

a. On the Power Distribution Board, three green LEDs should be lit: +5V supply, +24V 
supply, and +12V supply

b. On the Digital Sidecar, three green LEDs should be lit: “Power Input,” +5V, and +6V
c. On the Analog Breakout, one green LED should be lit.
d. On the Solenoid Breakout, one green LED should be lit
e. The Jaguar LEDs should be flashing yellow.
f. Note that the Driver Station display will provide status on communications with cRIO, 

code running state, etc.

2.8STEP 8 – BUILD AND LOAD PROGRAMMING
Teams that choose to program in LabVIEW should read section 2.8.1. then skip to 2.9 step 9 Basic 
Operator Control.  Teams that choose to program in C/C++ should read section 2.8.2. then skip to 
2.9 step 9 Basic Operator Control.  Teams that choose to program in Java should read section 
2.8.3. then skip to 2.9 step 9 Basic Operator Control.  

2.8.1 How to Build and Load a LabVIEW Program

Configuring an FRC Robot Project
1) Launch LabVIEW.
2) Click the FRC cRIO Robot Project link in the Getting Started window to display the Create 

New FRC Robot Project dialog box.
3) In the Project name text box, enter the name you want to use to identify the new FRC robot

project.
4) In the Project folder text box, enter the location on the host machine to which you want to 

save the project files and VIs.
5) In the cRIO IP address text box, enter the IP address of the cRIO to which you want to 

deploy the project. The IP address of the cRIO must be in the form 10.xx.yy.2, where yy 
corresponds to the last two digits of the team number and xx corresponds to the remaining 
first or first two digits of the team number. You can use the cRIO Imaging Tool to set the IP 
address of the cRIO.

6) Click the Finish button to close the Create New FRC Robot Project dialog box and create 
the new FRC robot project. LabVIEW displays the new FRC robot project in the Project 
Explorer window.

Running the FRC Robot Project



© FIRST 2010 FRC Control System Manual: Section 1 – Introduction, Rev1 Page 39 of 58

You can deploy the FRC robot project to the cRIO before making any modifications. In the Project 
Explorer window, right-click the Robot Main.vi item and select Run from the shortcut menu. 
LabVIEW deploys the Robot Main VI and any support files for the VI to the cRIO. The Robot Main 
VI then runs on the cRIO. If the robot has a joystick connected to port 1 of the driver station and 
Jaguar motor controllers controlling the two wheels, you can move the joysticks and observe how 
the robot responds.

You also can run the FRC robot project on the cRIO and maintain a connection with the host 
computer to perform live front panel programming and debugging. By maintaining a connection with 
the host computer, you can monitor indicators and observe how changes to the front panel of VIs 
affect the behavior of the robot.

Complete the following steps to run the FRC robot project and perform live front panel debugging.
1) In the Project Explorer window, double-click the Robot Main.vi item to open the Robot Main 

VI.
2) Click the Run button of the Robot Main VI to deploy the VI to the cRIO. LabVIEW deploys 

the VI, all items required by the VI, and the target settings to memory on the cRIO.
3) Move the joysticks and observe how the robot responds.
4) Click the Abort button of the Robot Main VI. Notice that the VI stops. When you deploy a 

program with the Run button, the program runs on the cRIO, but you can manipulate the 
front panel objects of the program from the host computer.

If you redeploy the Robot Main VI with the Run button, the cRIO stops and restarts the Robot Main 
VI. LabVIEW redeploys any VIs that changed or are no longer in memory on the cRIO.

Refer to the LabVIEW Robotics Programming Guide for the FIRST Robotics Competition for more 
information about creating and running a LabVIEW program. You can access this guide by 
selecting the Robotics Programming Guide link on the LabVIEW Getting Started window, by 
navigating to the National Instruments\LabVIEW 8.6\manuals directory and opening 
FRC_Getting_Started.pdf, or by searching ni.com.

2.8.2 How to build and load a C/C++ program

Creating the sample program
1. Launch WindRiver Workbench using the desktop shortcut.
2. Select “New” then “Example…” from the File menu.
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3. Choose “VxWorks Downloadable Kernel Module Sample Project” and click “Next>”.

4 Choose “Default Robot Main Program” from the list of choices presented and then click 
“Finish”.

5 Notice that the project is now loaded into the Project Explorer tab on the left panel of 
Workbench.
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6 If you double-click on the “DefaultRobot.cpp” file name in the Project Explorer, you’ll see the 
C++ source code in a tab in the main window in Workbench.

Building the sample program
1  To build the program, right-click on the project name in the project explorer and select “Build 

Project” from the pop-up context menu.

2   You should see the results of the build in the “Build Console” tab at the bottom of the 
Workbench window. If you don’t see these results, exit from Workbench and restart it, then 
rebuild the project.

Downloading the program
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1. Set up your team number in Workbench so it can find your robot. To do this, select 
“Window” and then “Preferences” from the main menu.

2. On the preferences window select “FIRST downloader preferences”. Then fill in your team 
number and the file to download to the robot. It will likely be:

C:\WindRiver\workspace\DefaultRobot\PPC603gnu\DefaultRobot\Debug\DefaultRobot.out

You can use the “Browse…” button to find it.

Once done these settings don’t need to be changed until you decide to work on a different 
project.

3. To download the program click on “FIRST” and then “download” from the Main menu in 
Workbench. If the cRIO is properly set up, the file will be downloaded.

Running the program
Reboot the cRIO to run the program and then proceed to section 2.9 to verify basic teleoperated 
and autonomous control of the robot. The steps here are described in more detail in the C/C++ 
Getting Started Guide available in: C:\WindRiver\docs\extensions or at: 
http://first.wpi.edu/FRC/frcupdates.html.

2.8.3 How to build and load a Java program
Creating the BuiltInDefaultCode Project

1) Launch NetBeans.
2) Select “File > New Project…”.
3) In the New Project Dialog, browse to “Samples > FRC Java”.
4) Select “DefaultCodeProject.zip”
5) Click “Next >”
6) Click “Finish”

NetBeans displays the new BuiltInDefaultCode project in the Projects window.

Building and Running the BuiltInDefaultCode Project
You can build and deploy the BuiltInDefaultCode project to the cRIO before making any 
modifications.  Before starting insure that the computer you’re using for software development is 
connected and configured with the correct IP address as instructed in Section 2.6. If you are using 
the Classmate Driver Station for software development, the IP address should already be correctly 
set.  If you are use another computer for software development, its IP address should be set to an 
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address that doesn’t conflict with the Classmate, robot or wireless bridge, such as 10.xx.yy.6 or 
10.xx.yy.10 (where xxyy is your team number). Complete the following steps to build and run the 
default code:

1) Right-Click on the BuiltInDefaultCode project name.
2) Select “Set as Main Project” from the pop-up menu.
3) Click the green “Run Main Project” arrow in the NetBeans toolbar.

The BuiltInDefaultCode will build, load and run on the cRIO.  You can proceed to section 2.9 to 
verify basic teleoperated and autonomous control of the robot.  Note that you may want to 
uncomment the autonomous code in BuiltInDefaultCode before building and testing.

2.9STEP 9 – BASIC OPERATOR CONTROL

2.9.1 Confirmation of “Tank Drive” Control System Component Operation
Before powering on the “benchtop” system, ensure that the motors are located in such a way that if 
they were to become immediately operational, they would not pose a safety hazard. Also ensure 
the joysticks plugged into the Driver Station are ‘centered’.

1. Move the joystick #1 Z-Wheel to the down position [-].
2. Power up the Classmate Driver Station and the benchtop system.
3. Set the Classmate Driver Station to “Operation > Enable”.  When enabled, the Jaguar LEDs 

should be solid yellow (assuming that the joystick inputs are centered.)
4. The “benchtop” system is now configured so that the two joysticks should give “tank drive” 

behavior. For an “out of the box” cRIO, you should observe the following behavior:
a. Move joystick #2 all the way forward. The Jaguar connected to PWM #1 should have 

its LED change color to green and the motor connected to that Jaguar should turn 
forward.

b. Move joystick #2 all the way backward. The Jaguar connected to PWM #1 should 
have its LED change color to red and the motor connected to that Jaguar should turn 
in reverse.

c. Joystick #1 full forward should result in Jaguar on PWM #2 having a red LED and the 
motor turning in reverse.

d. Joystick #1 full backward should result in Jaguar on PWM #2 having a green LED 
and the motor turning forward. 

2.9.2 Confirmation of “Arcade Drive” Control System Component Operation

1. Move the joystick #1 Z-Wheel to the up position [+].
2. The “benchtop” system is now configured so that joystick #1 should give “arcade drive” 

behavior. For an “out of the box” cRIO, you should observe the following behavior:
a. Move joystick #1 all the way forward while keeping the joystick centered from right to 

left. The Jaguar connected to PWM #1 should have its LED switch to green and the 
motor connected to that Jaguar should turn forward; meanwhile, the Jaguar 
connected to PWM #2 should have its LED switch to red and the motor connected to 
that Jaguar should turn in reverse.

b. Move joystick #1 all the way backward while keeping the joystick centered from right 
to left. The Jaguar connected to PWM #1 should have its LED switch to red and the 
motor connected to that Jaguar should turn backward; meanwhile, the Jaguar 
connected to PWM #2 should have its LED switch to green and the motor connected 
to that Jaguar should turn forward.

c. Move the joystick to each of the four “corners” – when completely in each “corner” 
only one motor should turn. (This would implement “pivot” turns on a typical FRC 
robot.)
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d. While holding down button 2 of the joystick, move the joystick from side to side. Both 
motors should turn with rates proportional to the distance the joystick is moved away 
from center. This would implement “spin” turns on a typical FRC robot.

e. Experiment with moving the joystick to different positions, noting that different output 
behaviors take effect depending upon the position of the joystick.

3. Set the Classmate Driver Station to “Operation > Disable.” 
4. Turn off the “benchtop” system by firmly pressing the red button on the Hi-Amp 120A circuit 

breaker.
5. Turn off the Driver Station by powering down the Classmate.

2.9.3 Confirmation of “Autonomous” Control System Component Operation
Before powering on the “benchtop” system, ensure that the motors are located in such a way that if 
they were to become immediately operational, they would not pose a safety hazard. Also ensure 
the joysticks plugged into the Driver Station are ‘centered’.

1. Turn on the Driver Station by powering up the Classmate. Wait approximately 35 seconds 
for the Driver Station to boot to the status screen.

2. Set the Driver Station to “Mode: Autonomous” using the buttons on the Operation tab of the 
DS.

3. Confirm that the screen reads “System: Disabled” and “Mode: Autonomous.”
4. Turn on the power to the “benchtop” system and wait for the cRIO to boot. Set the Driver 

Station to “System: Enabled” using the enable toggle on the Operation tab of the DS.
5. Set the Driver Station to “System: Disabled” in the Operations tab to disable the benchtop 

system.
6. Set the Driver Station to “Mode: Teleoperated” in the Operations tab.
7. Set the Driver Station to “System: Enabled” to re-enable the benchtop system with 

teleoperated control. Check that the motors move in accordance with the program coded for 
the joystick(s).

8. Set the Driver Station to “System: Disabled.”
9. Turn off the “benchtop” system by firmly pressing the red button on the Hi-Amp 120A 

breaker.
10. Turn off the Driver Station by switching to the setup tab and hitting the exit button, then 

logoff and power down the Classmate.

2.10 STEP 10 - CONFIGURATION OF WIRELESS COMPONENTS
Now that you have confirmed your benchtop system operates in tethered mode, set up wireless 
communications as follows:

 Configure wireless components (sections 2.10.1-2.10.3)
 Verify wireless operation for the benchtop system (section 2.10.4)

There are two wireless components in the control system:
• Linksys WRT610N or WRT160N Wireless Router – this device is to be physically connected 

to the Classmate and is part of the Driver Station.
• Linksys WGA600N Wireless Gaming Adapter / Bridge – This wireless device is to be 

physically connected to the cRIO and reside on the robot. Throughout the remainder of the 
documentation, this device will be referred to as the “wireless bridge” or simply “bridge.”

The default (i.e. out-of-the-box) configuration of the Linksys WGA600N Bridge, 
WRT610N/WRT160N, and Classmate WiFi require a few changes in order to operate properly 
within the FRC defined network architecture.

2.10.1 Configuration of Wireless Bridge for Robot (WGA600N)
The Robot radio, the WGA600N bridge, needs a few changes to the default settings in order to 
work correctly with the WRT610N or WRT160N router. Follow the steps below to make these 
changes:
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1. Set your computer to receive it’s IP via DHCP. 
2. Connect the computer’s Ethernet port on the Driver Station to any of the 4 Ethernet ports on 

the router using a standard 100-BaseT Ethernet cable. 
3. Connect the Bridge to any of the remaining 3 Ethernet ports on the router using a standard 

100-BaseT Ethernet cable. 
Note: If during this process, your computer prompts you to set up security, your 
computer probably has “Wi-fi protected setup” which will automatically set up the 
security settings on the router. If this happens, you will need to either change the 
settings on the bridge to match the router settings, or you will need to disable the 
security on the router. More information about Wi-fi protected setup can be found at 
http://wi-fi.org/files/WFA%20Wi-Fi%20Protected%20Setup%20FAQ.pdf . 

4. Open a web browser and navigate to the IP of the bridge, the default settings are:
a. IP: 192.168.1.250
b. Username: admin
c. Password: admin

5. Select "Basic" from the menu across the top of the webpage. 
6. Select "Wireless" to open the configuration page for the wireless settings. The configuration 

page is shown below:
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7. Change the "Wireless Network Name" to your FRC Team Number, no quotation marks. 
8. Configure all other settings to match those shown above.

a. NOTE: When using the WRT160N the “802.11 Band” option should be set to 2.4GHz
9. Click “Save Settings”
10.When asked to reboot now or later, choose “Reboot Now”
11.Login again.

a. Username: admin
b. Password: admin

12.Select "Basic" from the menu across the top of the webpage.
13.Select "Network Settings" to open the configuration page for the wireless settings. The 

configuration page is shown below:
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d. Configure the LAN Settings to match those shown above. In the IP Address and 
Default Gateway lines, replace “XX.YY” with your FRC Team Number.

14.Click the “Save Settings”
15.When asked to reboot now or later, choose “Reboot Now”. The login page will not reload at 

this point due to the IP address mismatch of the PC and bridge.

2.10.2 Configuration of VETERAN Wireless Router for Driver Station (WRT610N)
The WRT610N needs a few changes to the default settings in order to work correctly with the 
WGA600N. Follow the steps below to make these changes.  Note: The router may be reset to 
factory defaults by holding the reset button in the back for 5 seconds.

1. Set your computer to receive it’s IP via DHCP
2. Connect the computer’s Ethernet port to any of the 4 Ethernet ports on the WRT610N using 

a standard 100-BaseT Ethernet cable. 
3. Open a web browser and navigate to the web configuration tool of the WRT610N, the 

default settings are:
a. IP: 192.168.1.1
b. Username: leave this space blank
c. Password: admin

4. Select the “Wireless” tab, the default screen should look like the screen below.
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a. Check the “Manual” option
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5. Change the settings on the new page to match those shown below.

a. Enter your FRC Team Number is the SSID field, i.e. if you team number is 9999, 
enter 9999 in the field.

b. Click “Save Settings”
c. The “Settings are Successful” screen should now be displayed. Click “Continue”. If 

the web page does not reload, change the IP in the status bar to 192.168.1.1
6. Select the “Setup” Tab. 
7. Under “Basic Setup”, Make the following changes to in the “Network Setup” area of the page
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a. IP Address: 10.XX.YY.4, where “XX.YY” is the FRC team number.
b. Subnet Mask: 255.255.255.0
c. Change the DHCP “Start IP Address” field to 10
d. Click “Save Settings”
e. The “Settings are Successful” screen should now be displayed. Click “Continue”. The 

web page will not reload due to the IP mismatch between the PC and the 
WRT610N.

8. Configure your PC with a static IP 
a. IP Address: 10.XX.YY.10
b. Subnet Mask: 255.0.0.0
c. Gateway: 10.XX.YY.4

9. Open a web browser and navigate to the WRT610N’s newly configured address, 
10.XX.YY.4 to confirm that it has been set correctly.

10.Ensure the WGA600N is powered on, but not physically connected to the WRT610N. Open 
a web browser and navigate to 10.XX.YY.1 to confirm that the WGA600N’s IP address has 
been set correctly and that it is linked with the WRT610N.

2.10.3 Configuration of ROOKIE Wireless Router for Driver Station (WRT160N)
The WRT160N, needs a few changes to the default settings in order to work correctly with the 
WGA600N. Follow the steps below to make these changes:

1. Set your computer to receive it’s IP via DHCP
2. Connect the computer’s Ethernet port to any of the 4 Ethernet ports on the WRT160N 

using a standard 100-BaseT Ethernet cable. 
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3. Open a web browser and navigate to the web configuration tool of the WRT160N, the 
default settings are:

a. IP: 192.168.1.1
b. Username: admin
c. Password: admin

4. Select the “Wireless” tab, the default screen should look like the screen below.

a. Check the “Manual” option

5. Change the settings on the new page to match those shown below.

a. Enter your FRC Team Number is the SSID field, i.e. if you team number is 9999, 
enter 9999 in the field.

b. Disconnect the Ethernet cable between the WGA600N and WRT160N.
c. Click “Save Settings”
d. The “Settings are Successful” screen should now be displayed. Click “Continue”. If 

the web page does not reload, change the IP in the status bar to 192.168.1.1
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6. Select the “Setup” Tab. 
7. Under “Basic Setup”, Make the following changes to in the “Network Setup” area of 

the page

a. IP Address: 10.XX.YY.4, where “XX.YY” is the FRC team number.
b. Subnet Mask: 255.255.255.0
c. Change the DHCP “Start IP Address” field to 10
d. Click “Save Settings”
e. The “Settings are Successful” screen should now be displayed. Click “Continue”. The 

web page will not reload due to the IP mismatch between the PC and the 
WRT610N.

8. Configure your PC with a static IP address
a. IP Address: 10.XX.YY.10
b. Subnet Mask: 255.0.0.0
c. Gateway: 10.XX.YY.4

9. Open a web browser and navigate to the WRT160N’s newly configured address, 
10.XX.YY.4 to confirm that it has been set correctly.

10. Ensure the WGA600N is powered on, but not physically connected to the WRT160N. 
Open a web browser and navigate to 10.XX.YY.1 to confirm that the WGA600N’s IP 
address has been set correctly and that it is linked with the WRT160N.

2.10.4 Configuring the Classmate to connect wirelessly to the WRT610N or WRT160N 
wireless router [OPTIONAL STEP]



© FIRST 2010 FRC Control System Manual: Section 1 – Introduction, Rev1 Page 53 of 58

It may be convenient to setup the Classmate PC so that it does not need to be connected to the 
WRT610N or WRT160N router via a wired connection. The steps below outline setting up the 
Classmate PC to connect wirelessly to the router.

1. Click on the wireless radio icon in the system tray to open the window displaying the list of 
available networks.

2. Double-click on the wireless network which corresponds to your team number. For this example, 
the team number is 9999.

3. Enter the Network Key for this wireless network. If the wireless network was setup without 
encryption, this dialog box will not be displayed.

Once the negotiation is complete and the Classmate PC links with the router, “Connected” will be 
displayed in the Wireless Network Connection screen.
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Windows may also display a notification that the wireless connection has been established. This 
notice will detail the name (SSID) of the network and the signal strength.

Disconnect the wired connection between the Classmate PC and the router. You should now be 
able to connect to the robot via wireless link.

2.10.5 Verification of Wireless Operation 

Repeat the tests described in section 2.8 with the “benchtop” system now connected wirelessly to 
the Driver Station NOTE: This step does not require that the Classmate be configured to connect 
wirelessly to the router. Wireless link between the WGA600N robot radio and WRT610N/WRT160N 
router is sufficient.

2.11 STEP 11 – CONFIGURATION OF I/O MODULE 
Now that you’ve confirmed that your basic Driver Station hardware and software is functional, add 
the I/O layer. Before using your Cypress FirstTouch I/O module, you must first program firmware 
into the USB chip on the board. The steps below will walk you through the process. Remember that 
you only need to do this step once per board. Make sure that you have the most recent version of 
the Driver Station software before proceeding. 

1) Log into the Developer account.
2) Plug the USB cable provided in the FirstTouch starter kit into the I/O module and the Classmate.
3) Allow the computer time to find and connect to the new hardware.
4) Next, open the Cypress PSoC Programmer. To do this, click on Start > All Programs > Cypress 

> PSoC Programmer. If you get an Update Reminder, cancel it. 
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5) In the top left of the tool bar, you’ll see a blue folder icon. Click the folder, browse to where you 
saved FRC_IO.v1.hex, and select the FRC_IO.v2.hex file.  

6) Directly below the tool bar, on the left, there is a Port Selection window with the device listed in 
it. Select the FirstTouch device.

7) Click the program button on the tool bar, and wait for the programming operation to complete. 
You will see Programming Succeeded in the Results window. 
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8) Unplug and replug the USB cable and your I/O module will be ready to use. You can check to 
make sure the process was successful by opening the Driver Station software and confirming 
that the device is being recognized. With the I/O module plugged in, your I/O tab will indicate 
that the Hardware I/O is selected. Without the I/O module plugged in, it will default to the Virtual 
I/O.

2.12 STEP 12 – CONFIGURATION OF CAMERA
The camera comes with a network address of 192.168.0.90 and a root password of “pass”. The IP 
address is kept but the password for root must be updated to “admin” to work with the camera 
access software.

Manual Configuration of the Camera
The username/password combinations that work with the default code are shown in the table 
below. As long as at least one of these users is configured, the camera initialization software will 
work.

User name FRC
Password FRC
root pass (Axis default, must be changed)
root admin 
FRC FRC

To change passwords:
1. Connect your computer to the camera using a crossover Ethernet cable.
2. Set your PC’s IP address to 192.168.0.XX where XX is something not in use (1-255), for 

example 192.168.0.6. See section 5.2.1 for instructions on how to set a static IP 
address.

3. Close the window and wait while it configures the network card.
4. Navigate your web browser to http://192.168.0.90/.
5. If a “Configure Root Password” dialog box pops up, enter the username "root" and the 

password "pass".
6. If a login dialog pops up, enter the username "root" and the password "pass" (this is the 

default password).
7. In the top right, click "Setup"
8. On the left, click "Users"
9. Click "root" and click "Modify"
10. Enter the password “admin” twice in the password box.
11. Click OK, then Save.

Camera tools and documentation
Vendor information about the Axis 206 camera can be obtained at the web site: 
(http://www.axis.com/products/cam_206/index.htm)
An installation and management tool from Axis is available from this site that is can be used to set 
the camera configuration. (http://www.axis.com/products/cam_mgmt_software/index.htm)


